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A MESSAGE FROM NEW RIDERS

At New Riders, we work hard in building and maintaining valuable relationships—partnerships, really—with our authors. We
consider ourselves quite fortunate to be associated with such talented, creative, detail-oriented, selfless and genuinely cool people
as the authors of this book, Barry Haynes and Wendy Crumpler. Thanks, you two.

New Riders is proud of every title we publish. But some titles... some titles we keep in mind when we really want to show off.
Photoshop Artistry is one such title.

Judging from the response that Barry and Wendy’s previous editions of this book have earned from reviewers, students, and
countless satisfied users, Photoshop Artistry may well be the best Photoshop book available anywhere, for any audience, for any
price. It's a unique book, designed to bring out the uniqueness in you, the Photoshop user. Please let us know how you use the
book and how the book works for you. Thanks. ..

HOW TO CONTACT US

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what
we're doing right, what we could do better, in what areas you'd like to see us publish, and any other words of wisdom you're willing
to pass our way.

As the Executive Editor for the Graphics team at New Riders, I welcome your comments. You can fax, email, or write me directly
to let me know what you did or didn't like about this book—as well as what we can do to make our books better.

Please note that I cannot help you with technical problems related to the topic of this book, and that due to the high volume of mail
I receive, I might not be able to reply to every message.

When you write, please be sure to include this books title, ishn and authors, as well as your name and phone or fax number. I will
carefully review your comments and share them with the authors and editors who worked on the book.

For any issues directly related to this or other titles:

Email: steve.weiss@newriders.com
Mail: Steve Weiss
Executive Editor
Professional Graphics and Design Publishing team
New Riders Publishing
201 West 103rd Street
Indianapolis, IN 46290 USA

Call toll-free (800) 571-5840 + 9 + 3567. Ask for New Riders.
If outside the USA, please call 1-317-581-3500. Ask for New Riders.
Fax: 317-581-4663

VISIT OUR WEBSITE: www.newriders.com

On our website you'll find information about our other books, the authors we partner with, book updates and file downloads,
promotions, discussion boards for online interaction with other users and with technology experts, and a calendar of trade shows
and other professional events with which we’ll be involved. Maybe we’ll see you around.

ABOUT THIS VERSION OF PHOTOSHOP ARTISTRY

New Riders and the authors decided to update Photoshop 5 Artistry to include coverage of Photoshop 5.5 because it didn’t seem
appropriate to not have a version of Photoshop Artistry available to anyone new to Photoshop during the 5.5 rev cycle.

Suffice to say: If you already own a copy of Photoshop 5 Artistry, you may not need this upgrade version of the book, just as if you
already own Photoshop 5, you probably already own ImageReady and haven’t seen a huge need to go out and upgrade to 5.5. Of
course, this all changes when Photoshop 6 releases: Look for Photoshop 6 Artistry to be rewritten from the ground up, the better
to reflect the changes we're all expecting to see in the next gen version of Photoshop...
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LET US KNOW WHAT YOU THINK
There’s been a lot of student and reader involvement in the shaping of this book. Listening to people who
use these techniques helps us to refine and dig deeper to find solutions to our clients” and students” problems.
And, we get smarter in the process. We love what we do and invite you to become part of the digital revolution
with us. Let us know what you think of the book, what was helpful, what confused you. We are committed to
empowering people to use their computers and their software to advance their own artistic abilities and to
make a difference on this planet.

TAKE ONE OF OUR IN-DEPTH WORKSHOPS

We recently moved to Corvallis, Oregon, an arts-oriented college town where we will be teaching week-
long hands-on classes for small groups of students. These classes will be tailored to meet individual needs. Our
next book project is a comparative guide to Photoshop, Painter, and Illustrator. We welcome insights you might
have into using those three programs together, discussions of work you've done using them, or work that you
need to accomplish that we can do for you using all three. Send information on this new project and check for
the latest information about the times and locations for our digital imaging courses, as well as book updates,
and other useful information on our Web site, www.maxart.com.

WE LOOK FORWARD TO HEARING FROM YOU!
Barry Haynes Photography
Wendy Crumpler Enterprises
2222 NW Brownly Heights Drive
Corvallis, OR 97330
541-754-2219
email: Barry@maxart.com, or Wendy@maxart.com
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FOREWORD

Ansel Adams, discussing the decision to make his original negatives available for
future photographers to print, wrote in his autobiography that

“Photographers are, in a sense, composers and the negatives are
their scores. ...In the electronic age, | am sure that scanning
techniques will be developed to achieve prints of extraordinary
subtlety from the original negative scores. If | could return in
twenty years or so | would hope to see astounding interpreta-
tions of my most expressive images. It is true no one could print
my negatives as | did, but they might well get more out of them
by electronic means. Image quality is not the product of a
machine, but of the person who directs the machine, and there
are no limits to imagination and expression.”

Ansel Adams had a good vision for the future that we are now living. We hope
this book will help you experience that vision in your photographic work.

Seeing an image on the computer screen is a beautiful thing. You bring it up
from the scanner and you begin to think, “Now what do I really want this to look
like?” If you know the Zone System, developed by Ansel Adams in traditional pho-
tography, you know the type of control you can have while taking a photo or printing
it in the darkroom. On the computer screen, you can have this control and much
more. You can try numerous variations, making extreme or subtle changes easily and
quickly. The computer is a tool that enables the photographer to get precisely what
he or she wants.

Many people think of using computer imaging for its proven capability to cre-
ate special effects and image composites. It is very good at this, and we will show you
how to create images that you cannot do optically in the darkroom, but I often use
my computer darkroom to make a print of nature because it gives me much finer
control in making that print. Realistic photography is another area in which we will
show you things that you can do on the computer that you can't do easily or at all in
the darkroom. Hey. I recently finally sold my dar kroom!

This book has dev c]opcd from Photoshop courses I started teaching in 1990. It’s
not an exhaustive book that goes through each menu bar and each feature, listing
them in order. The examples in Photoshop 5 Artistry teach you how to use Photo-
shop 5 by working with typical situations that you encounter as a photographer, artist,
or pm(lucﬁ()n artist. This is Photoshop for creating fine images that are sometimes
high-quality reproductions of reality and sometimes fine renditions of composites
and effects.

In this third edition, we have added all the information you will need to use the
new Photoshop 5 features including Color Calibration and Color Management. We
not only show you valuable techniques, but we give you a strategy for managing your
digital images by creating an RGB or Lab master file for each image, which you can




then use (automating using actions) to create different RGB files for color trans-

parency, digital laser, dye-sub or inkjet printers, multimedia, or Web images and
icons. These files, used with other actions. can create custom CMYK images for each
of your printing situations.

For each situation, we spell out the detailed, step-by-step process. You can prac-
tice the technique yourself because the original images, masks, and progress steps,
as well as the final images for each example, are included on the Photoshop 5 Artistry
CD that accompanies the book. We have taught these examples over the past eight
years to thousands of students across the country. Their feedback has helped us
refine these exercises to make them easy to understand. concise, and full of special
tips for more advanced users. All the the exercises have been updated and changed
so that you can take advantage of the latest features, such as the new Photoshop 5
color capabilities, and deal with current trends like making images for the Web. In
addition to student tested, step-by-step instructions, Photoshop 5 Artistry includes
explanations of concepts like color correction, calibration, 24- and 8-bit file formats
and compression, duotones, selections, masking, layers, laver masks, Adjustment lay-
ers, history, and channels, so you really understand what you are doing and are not
just blindly following directions. Understanding allows you to expand the ideas in this
book as you apply them to your own situations and creations without wasting your
time on unnecessary issues.

We start with simple examples like cropping and color correcting a photograph.
We cover color correction in great depth, and then move into things that you nor-
mally would do in the darkroom, like changing the contrast, burning and dodging,
removing spots and scratches, and making a nice photographic print. Before we get
into compositing and special effects, we talk about the importance of having absolute
control over the colors in your photographs—which you can do more easily now with
the new Photoshop 5 color management features. The masters of color photography
have used contrast reduction masks, shadow, highlight, and color masks in the dark-

room to make very fine Ilfochrome, C, and dye transfer art prints. Now many of

them are switching to digital techniques and making LightJet 5000 prints. Using
these techniques, you can make specific colors pop by increasing their saturation and
changing their relationship to the rest of the photograph. Photoshop 5 Artistry shows
you how to do all these things digitally using Adjustment layers, layer masks, and
multiple layers of the same image, and how to generate art-quality output to Light-
Jet 5000, Fugix, dye sublimation, color laser or inkjet printers, or to the Web. We also
talk about enhancing an image for output back to 4x5 and 8x10 film as well as for out-
put to separations for printing on a press. We also show you how to use the above
techniques along with sharpening to get great quality prints from Photo CD and Pro
Photo CD scans.

After we explain how to make a fine color print using Photoshop, we make exten-
sive use of layers, laver masks, and image compositing techniques. You can do com-
mercial compositing techniques easily using Photoshop, and we present step-by-step
examples for some simple compositing jobs and then move on to some more complex
examples that involve using hard- and soft-edge masks, as well as a variety of shadow
and drop shadow effects and all the features of Layers, Adjustment Layers, and Layer
Masks. The Apply Image and Calculations commands, as well as the Blend mode vari-
ations, are explained in detail along with examples of where to use them.

Photoshop 5 Artistry also includes many tips and techniques on getting the most
from the Photoshop filters. We explain Layer options and also get into creating duo-
tones and bitmaps, adding textures to images. and other fun things.




Photoshop is great fun! And the more you know, the better time you will have

and the easier it will be to turn the images in your mind into reality. We hope Pho-
toshop 5 Artistry helps you have more fun than ever before with photography and
digital imaging.

Happy Photoshopping!

P.S. Those of you who already have Photoshop Artistry or Photoshop 4 Artistry
will notice that the techniques in all the Photoshop 5 Artistry examples have been
improved to take full advantage of the great features in this new version. You can
compare this book to the Photoshop 3 or 4 versions and quickly see how to use the
new features. Use our “Taking Advantage of Photoshop 5” chapter to get a quick
overview of the new features and get through the transitions to the new Photoshop
5 command keys. At the end of “Taking Advantage of Photoshop 5.” there is a table
of the new command keys added for Photoshop 5. We also have added new chapters
to help you learn about the new History Palette and Brush, all the new Free Trans-
form and Transformation possibilities, the new Color Spaces, Preferences and Cali-
bration, Spot Colors, the new Portable and Multimedia Composite examples, and the
latest info about creating Web images. Many more new features and techniques are
distributed throughout the book. The CD has updated ArtistKeys to set up your
Actions palette and to give you a great set of function keys and automated sequences
for bringing palettes up and down, converting file formats, and doing other useful
but repetitive tasks.

Foreword



TAKING ADVANTAGE OF PHOTOSHOP 5

Easing the conversion from Photoshop 4 to 5,

making sure you are taking advantage of

the important new features in Photoshop 5.

Photoshop 5 is a maturing of Photoshop in which some of the features
we have always wanted, like multiple undo and full color and separation sup-
port, have finally arrived. This is a major release of Photoshop that daily users,
especially photographers and digital imagemakers, will want to have. You will
find it to be a much more complete and well-integrated creative tool through-
out. Photoshop 5 Artistry has been completely updated to take full advantage
of the new Photoshop 5 features. The new features are described and used
throughout the book. This chapter is a summary of the major new features
and will point to the best chapters in the book for you to use to learn about
each feature. In this chapter, we point out the features you are most likely to
use. Each feature mentioned herein is explained in great detail in the appro-

priate chapter of Photoshop 5 Artistry. To find more detail about a feature,

follow the references mentioned here or look it up in the index or table of

contents. At the end of this chapter is a table of all the new Photoshop 5
shortcut keys. References in this book to the Option key should be translated
to the Alt key on Windows systems, and the Command key here is the Con-
trol key in the Windows world.

BETTER SUPPORT OF CALIBRATION, COLOR MANAGEMENT,
AND COLOR SEPARATIONS

Photoshop 5 has much more advanced support for Color Management of

your files and workflow. Similar to the way that Photoshop 4 modified the
appearance of CMYK files on the screen depending on your Printing Inks
Setup settings, Photoshop 5 allows you use File/Color Settings/RGB Setup to
set the preferences for how your RGB files appear on the screen. This more
ideal situation allows you to dloose an RGB space to work in that may encom-
pass a wider gamut of colors than what your monitor can actually display. After
using the new Adobe Gamma tool, or other hardware/software methods, to
characterize your monitor with an ICC profile, Photoshop does its best to pre-
view the images from the color workspace you have chosen onto the monitor
you are working with. In theory, this allows people with different types of mon-
itors to work on files within the same RGB workspace and have those files look
as close as possible on those different monitors. For this to work correctly, the
ICC profile for your monitor has to be accurately produced and you need to
choose the correct RGB space for the type of color work you are doing,
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The new CMYK Setup dialog gives you exact con-
trol over all your Dot Gain curves when converting
from RGB to CMYK. You can also select from dif-
ferent built-in CMYK models or use ICC profiles for
CMYK conversion.

RGB Setup
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The new RGB setup dialog allows you to set the
RGB color space for the type of files you use. Pho-
toshop will then preview that workspace on your
monitor using your monitor’s ICC profile. This
makes setting up for working in RGB more compli-
cated but allows you to get more accurate monitor
previews while not throwing out useful RGB data.




= Profile Setup =

I Embed Profiles
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The new Profile Setup preferences dialog allows you
to set up what Photoshop does when opening files
with different color tags than your default configu-
rations. You should probably set most of these
options to Ask When Opening until you get used to
the new color system. This way you'll be sure you
know what is happening to your files as they are

opened.
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The History palette allows you to keep track of your
changes. Command-Z still toggles between Undo
and Redo of the last Photoshop command. Now
Command-Option-Z marches back through the His-
tory palette, undoing one thing at a time, and Com-
mand-Shift-Z redoes things in the order that they
appear in the History palette. When you save a file
or quit, the History palette for that file goes away.

You can now define custom dot gain curves for all four colors
in CMYK setup. Your CMYK space and color separations can also
be defined using ICC profiles. The Custom Inks setup in CMYK
Setup now also allows you to enter Lab coordinates.

1CC profiles are used with ColorSync on the Mac and prob-
ably ICM2.0 with Windows. Photoshop 5 does have its own
engine for transforming from one profile to another, which Adobe
claims is more accurate than the ColorSync 2.5 engine. You have
the option to use either the Photoshop built-in engine or Color-
Sync to do conversions.

It is very important that you read the “Color Spaces, Device
Characterization, and Color Management” chapter and then the
“Calibration” chapter to understand this new built-in color sys-
tem. After reading these, use the “Setting System and Photoshop
Preferences” chapter to set up your color settings. Do these
things before doing serious color work with Photoshop 5, or you
could be disappointed and confused with your color results!

THE HiSTORY PALETTE AND HISTORY BRUSH
G1vE YoUu MULTIPLE UNDO AND MUCH MORE

The new History palette keeps track of each step that you
make, up to 100 steps, as you work on your image. Every time you
do something, a new line is added to the History palette for that
step in your process. This is better than multiple undo because by
clicking one of these states in the palette, you can instantly return
to that state in your image. If you then start editing again, the steps
you made after that all disappear. You can also choose the History
Options and turn on Allow Non-Linear History; then when you
start editing again, your old steps stay in the History palette in case
you later want to reuse them.

The History palette also allows you to take a snapshot of your
image at any time. These snapshots stay around at the top of the
palette and, at any point, you can click one of them to return to that
state. The History Brush is a new painting tool that will paint on
your current image from any previous snapshot or from any previ-
ous history step currently in the History palette. You can remem-
ber up to a maximum of 100 steps of history. The actual number
you remember is a value you set in the History Options. The old
Rubber Stamp or Fill From Saved options have now changed due
to the History system. You now use the History Brush instead of
the Rubber Stamp with either the From Snapshot or From Saved
option. This gives you more flexibility because you can paint from
the image at any previous step, or any snapshot, in the history. You
can also fill from the state or snapshot specified in the History
palette. The History palette and everything in it goes away when
the file or Photoshop is closed. For more info about the History
palette, see the new “History Palette, History Brush, and Snap-
shots™ chapter on page 89.

Taking Advantage of Photoshop 5



FREE TRANSFORM OF SELECTIONS AND PATHS, PLUS A CENTER

POINT FOR ROTATE TRANSFORMATIONS

The Free Transform of a layer that was added in Photoshop 4 has now been

generalized and expanded to allow you to also do Free Transform of selections and

paths. You can also do the rest of the transforms (Scale, Rotate, Skew, Distort, Per-

spective, Numeric, and so on) on selections and paths. Most of the Trans-
form commands have been moved from the Layer menu to the Edit menu.
When you have a path or point active, the name will change to Transform
Path or Transform Points. When you have a selection, you can choose one
of the Transform commands from the Edit menu and the area within the
current layer that is selected will be transformed. With a selection, you can
also choose Select/Transform Selection, which allows you to Free Trans-
form the selection marquee itself! Very cool stuff indeed.

All transforms in Photoshop now also have a center point around
which the Rotate transformation happens. Just click the center point and
drag to move it to a new location. Command-T gives you Free Transform
and now Command-Shift-T repeats the last transform. For more informa-
tion on transforms of all kinds, see the new “Transformation of Images,
Layers, Paths, and Selections” chapter.

A MucH BETTER BuiLT-IN TYPE TOOL

Photoshop has finally improved its Type tool. There is now a vertical
and horizontal Type tool, and selection versions of both of these. For reg-
ular type, not selection type, the type ends up in a special type layer than
can now be edited after the fact. Within the type layer, you can double-click
the layer name and go back to change the font, size or actually change the
letters in the text. Type layers can also have Drop Shadows and the other
new Layer Effects added to them, and then even later taken away or
changed. It’s a whole new world where you can even use the new command
keys to align, resize, change leading, kerning/tracking, baseline shift, and
other useful functions. However, you will still end up using Illustrator or
another vector program if you want to set type on a curved path or do any-
thing like that. See the “Tool Palette™ chapter for a more complete descrip-
tion of the exciting new type functions. To get the new command keys for
type, see the New Command Keys table at the end of this chapter.

MAGNETIC LASSO AND PEN SELECTIONS, AS WELL AS
THE FREEFORM PEN TooL

The Magnetic Lasso and Pen tools are new for Photoshop 5. They will
help you more easily make selections by doing the fine detail selection work
along a contrasty edge as you simply move the mouse fairly closely to the
edge of the area you want to select. You use the Lasso Width, Frequency,
and Edge Contrast settings to hone in on the type of edge you are select-
ing this time. These seem to work quite well on contrasty edges. Adobe has
also added the FreeForm Pen tool, which allows you to make a path by

Here we see a transform of a selection where we
are rotating around a center point that has been
moved to the top-right of the box.

S |
sasetine:[ ]

[JAuto Kern & Anti-Allased [ Rotate

The improved Type tool can be re-entered to edit
type and change the font, size, kerning, tracking,
baseline shift, or color, after the initial type creation.
Way to go Photoshop, finally!

Magnetic Lasso Op' >
Feather : EI pixels [ Anti-aliased [

Lasso Width: E] pixels ;
Freq y: E Edge Contrast: E%1
2 [« Stylus: [JPressure 1

The Magnetic Lasso and Pen tools have this new
set of options to help you automatically make a

selection.

freehand drawing like you would with the Lasso tool. This seems to do a good job
defining the path and does it in a way that makes the path easily editable after the
initial drawing. For lots more about these new tools, see the “Tool Palette” chapter.
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The Drop Shadow effect and its options.
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The Inner Shadow effect and its options.
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The options for the new Spot Color channels.
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The new Hue/Saturation tool dialog. You can click in
the image to specify the color range you want to
modify. This makes the Hue/Saturation tool much
more flexible because it can now modify any range
of colors you select.

Ty

The Outer Glow effect and its options.

BUILT-IN LAYER SHADOW/EDGE EFFECTS AND ALIGNMENT OF
LINKED LAYERS

Drop shadows are now as easy as pie! For any layer that has a transparent area
around it or inside it, like text or a button for example, Photoshop 5 now has built-in
Shadow and Edge effects. Above are some of their names and what they look like.

For more information on these new shadow and edge features, see the “Creat-
ing Shadows and Edge Effects™ chapter.

Photoshop has also added some useful commands to align or distribute the lay-
ers linked to the current layer on the top, vertical center, bottom, left, horizontal cen-
ter, or right. You can also align the active layer, and those linked to it, to a selection
in the same six ways. These features will be very useful to those working on Web and
multimedia projects. For more features on these new layer alignment features, see
the “Layers, Layer Masks, and Adjustment Layers” chapter.

BuiLT-IN SPOT COLOR SUPPORT WITH OUTPUT TO DCS 1.0
AND 2.0, FLASHPIX & PDF IMPORT/EXPORT

Photoshop 5 now has built-in spot color support, which will come in very handy
for some people. When you add another channel to the Channels palette, it can be
added as a Spot Color channel. You can then use the Custom Color picker to pick a
Pantone or other spot color for that channel. The Spot Color channels can be output
as separate channels in Photoshop, DCS 2.0, or TIFF format. When a Spot channel
is active, you can also use the Merge Spot Channel command in the Channels palette
to merge this channel and its effects into the current RGB or CMYK channels.

IMPROVED HUE/SATURATION AND CURVES TOOLS, AND THE
NEW CHANNEL MIXER

The Hue/Saturation and Curves tools have been greatly enhanced for Photo-
shop 5. You will find that they now allow you to make much more accurate selections
of color ranges. The Hue/Saturation tool allows you to use the Eyedropper on the
screen to initially select and then, with the new Plus or Minus Eyedropper, tweak the
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color range you are going to modify with Hue, Saturation or Lightness changes. To
add or delete colors, you can either click or click and drag a range within the image
using the plus and minus droppers. You can also move the sliders on the color ramp
at the bottom of the dialog to narrow or widen the part of the spectrum you are
working with. At the bottom of the dialog, the topmost spectrum shows you the
before colors and the bottom spectrum shows vou the after colors.

The Curves tool also has some impressive improvements. The display of the
points on the curve is easier to see with the active point being all black and the other
points being small circles. You can create a point on the curve now by Command-
clicking somewhere on your image (use Command-Shift-click to add individual
points to each color curve): then you can move the active point one value at a time
using the arrow keys (Shift-Arrow for 10 values at a time). You can also type in a new
value for the active point. Command-Tab toggles the active point to the next one pre-
sent and Command-Shift-Tab to the previous one. You can even use Shift-click to

select multiple points on the curve

and then move them all as a group.

Far out! As in Select/Deselect, Com- 05E]% wl %
' : P s % w[_]%

mand-D is used to deselect all points ::%: :‘:

on the grid. T =[x = Jx C=)
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The new Curves dialog now has the vertical gradi-
ent to help people understand the output axis. You
can now type in the location values of the current
point or you can use the arrow keys to move the
point by one value at a time (Shift-arrow for 10 val-
ues at a time). You can also add points to the curve
by Command-clicking that point on the screen.

especially useful when deciding what o -
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color space to work in for your RGB
and CMYK files. The preferences
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BETTER COLOR SAMPLING
AND MORE 16-BIT
CHANNEL SUPPORT

LB e

The new Color Sampler Eye-
dropper allows you to click on up to
four points within your image whose

Here we have used the Color Sampler Eyedroppers to enter four locations whose values we want to keep
track of while we are color correcting. As we make changes in Levels and other correction tools, we simul-

values are added to the Info palette's taneously see what these changes do to these four points. This is a color corrector’s dream!
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display. When you are making any color correction changes, those changes’ effects

on the four Color Sampler points are displayed within the Info palette. You still see
the Info readouts for the current location of the cursor as you always have.
Photoshop 5 now supports 16-bit channel files in Levels, Curves, Hue/Satura-
tion, Brightness/Contrast, Color Balance, Equalize, Invert and Channel Mixer. You
can also Crop, Rubber Stamp, Image Size and Rotate Arbitrary as well as use the
History Brush with 16-bit channel files. The advantage of these files (48 bits per pixel
for RGB and 64 bits per pixel for CMYK) is that they allow one to save all the infor-
mation obtained from a high end scanner, and then manipulate this information
without having to throw away values converting to 8 bits per channel. Even though
you can't see all the 16-bit color detail on the monitor, working in 16-bit color allows
Photoshop’s calculations to be done without losing information due to rounding and
truncation errors. When the corrections are finished, the final files can be converted
to 8-bit color for output and you should end up with a better final 8-bit result. The
argument for doing this is similar to the reason you want to do all your Web color
correcting in RGB until you get to the final step, and then you convert to a GIF file
or save your Web version as a JPG. You still get better results doing all your manip-

= Indexed Color =

Palette: | Adaptive A
0K ]
Color Depth: | 8 bits/pixel = l
Colors:
— Options 4 Preview
Color Matching: O Faster @ Best
| [ Preserve Exact Colors

At the bottom of the dialog, you see the new Color
Matching options for Index Color. These allow you
to produce better 8-bit color files for your Web
sites and multimedia documents.

= NewAttinnEFeee————=——

| | Record |
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Name: [A New Action{

Set: Barry's Actions 1/3/98
FunctionKey:(FI____ 2] Ashift [JCommand
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Actions now support different sets of Actions. This
gives you a way to organize your Actions. The func-
tion keys are global to all the sets, so you cannot
reuse the same function key in two different sets.
Besides Shift, Photoshop 5 allows you to also use
the Command key as a Function Key modifier, and
you can use both Shift and Command. This gives
you twice as many function keys as you had avail-
able in Photoshop 4.

Playback Options

Performance
@ Accelerated
(O Step by Step

(O Pause For:Dseconds

Photoshop 5 also gives you these three choices for
your Action’s playback speed.

ulations within the larger color space. Now that memory is cheaper and
hard disk space is larger, I believe we will start to see more people working
with 16-bit files.

BETTER SUPPORT FOR INDEX COLOR

Besides getting a preview in the Index Color Mode Change dialog,
there are also improvements in the quality of the Index Color files created.
Adaptive palette creation is touted as being better and you now have the
options of choosing Faster or Best color matching. If you turn off Best, then
dithering and conversion is a little lower quality but a lot faster. The Pre-
serve Exact Colors option does not dither colors in your image that are an
exact match for colors that are in the palette you use. This may do a better
job of preserving detailed lines and text, depending on the prevalence of
those colors within the image and palette. For more information about
Index Color, see the “Differences in Creating for the Web and 8-Bit Color,”
as well as the “GIFs, JPEGs, and Color Palettes™ chapters.

BETTER ACTIONS SUPPORT AND BATCH CONTROL

In addition to what Photoshop 4 Actions could do, in Photoshop 5.
Actions can be organized into different sets. Now twice as many function
keys are available and you can control the speed of Action playback. When
in Batch mode, you have the option of stopping an Action upon an error, or
just recording the error in a file and continuing. If you are running a Batch
from a folder, you can decide whether to Include all Subfolders in the
Action or not. Photoshop 5 Actions can now also record things from the
Paths, Layers, and History palettes using the Gradient. Marquee, Crop.
Lasso, Line, Move, Magic Wand, Paint Bucket, and Type tools; the Light-
ing Effects filter; and the Calculations, Apply Image, File Info, and Free
Transform commands. Actions can also record switching and selecting doc-
uments. If you want to be able to record relative positions, set the ruler
units to the new Percent option.
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PLUG-IN CONTROL OF PHOTOSHOP FUNCTIONALITY

In the File/Automate menu, you will notice Conditional Mode Change, Contact
Sheet, and Fit Image, which are implemented using Photoshop’s new capability to
control functions from within a Plug-In module. The Export Transparent Image and
Resize Image commands in the Help menu are also implemented this way. You will
probably l)e seeing some third party plug-ins that use this feature for a variety of pur-
poses. It is a powerful addition to what can be done with Photoshop for sure. We'll
just have to see what comes along to make use of this neat feature.

CHANGES TO THE RUBBER STAMP AND PEN TOOLS

Because the History Brush now enhances the old Rubber Stamp functionality
of the From Saved and From Snapshot options, these options are no longer available
in the Rubber Stamp tool. This tool has been further dissected by dividing it into two
tools, the Rubber Stamp and the Pattern Stamp tools. Although we now have two
tools, which are both selected from the Rubber Stamp pop-out in the Tool palette,
there really is no additional functionality here. Is this a case of Adobe saying, “wow,
a new tool,” when they just added more user interface to the tool you used before?
Well, the History Brush part of the Rubber Stamp’s demise is certainly a new and
much more powerful tool. The two separate Rubber Stamps that are left don’t add
anything new to what you had in Photoshop 4. The other changes in user interface
are that you turn on the Aligned option to do Clone Aligned or Pattern Aligned, and,
of course, you are doing Non-Aligned if this option is turned off: also the old Sam-
ple Merged option is now called Use All Layers. Still, both these things allow the

same functionality as was available before.

OTHER NEW FEATURES OF NOTE

* Photoshop 5 now supports Postscript Level 3

¢ Brush Sizes can now be up to 32000x32000 on thv Mac.

e Tools now show the Cancel sign when they are unusable, due to the current sit-
uation. A single click on the Cancel sign will beep once; a double-click will tell
why the tool can’t currently be used.

e You now can use the Paths Palette only, not the Save As EPS dialog, to set the

clipping path.

There are some new features that seem like token user interface changes that

don’t add much or any functionality. The most prevalent of these is the changing of

sliders, like the Opacity slider in the Layers and Brushes palettes, to pop-down slid-
ers. The only added functionality here is that you can always type in a value by select-
ing the number box and typing the number. T don’t usually want to do this because I
have to move the mouse and make a selection. The old way of just typing a number
still works and is much faster. I'm finding the actual slldm(y of the slider a bit more
awkward because the slider has to now pop down and out when you click the arrow.
It seems like in a lot of cases it was faster before in Photoshop 4. Maybe this change
was required by Mac or Windows User Interface Standards.

Rubber Stamp Options \
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Here is the “new"” Rubber Stamp tool. Notice that
Aligned is now a checkbox item instead of a differ-
ent mode of the tool. The old Sample Merged is

now called Use All Layers. This name is better!

Pattern Stamp Options \
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Here is the “new"” Pattern Stamp Tool!
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